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• 安全注意事项 • 
(使用之前务必阅读) 

 

在使用本产品之前，应仔细阅读本手册及本手册中所介绍的关联手册，同时在充分注意安全的前提下正确

地操作。 

本手册中的注意事项仅记载了与本产品有关的内容。关于可编程控制器系统方面的安全注意事项，请参阅

CPU 模块的用户手册。 

在·安全注意事项·中，安全注意事项被分为“危险”和“注意”这二个等级。 

 

注意根据情况不同，即使 ! 注意这一级别的事项也有可能引发严重后果。 

对两级注意事项都须遵照执行，因为它们对于操作人员安全是至关重要的。 

 

妥善保管本手册，放置于操作人员易于取阅的地方，并应将本手册交给最终用户。 

 

[设计方面的注意事项] 

!  危险 

● 通过个人计算机对运行中的可编程控制器进行数据变更、程序变更、状态控制时，应在可编程控

制器系统的外部配置互锁电路，以保证整个系统总是能向安全的方向动作。 

此外，在通过个人计算机对可编程控制器 CPU进行在线操作时，应预先确定由于电缆的接触不良

等导致数据通讯异常时的系统方面的处理方法等。 
 

[启动、维护时的注意事项] 

!  注意 

● 将个人计算机连接在运行中的可编程控制器 CPU 上进行在线操作(在可编程控制器 CPU 处于运行

状态下的程序变更、强制输入输出操作、RUN-STOP 等运行状态的变更、远程操作)时，应在熟读

手册，充分确认安全后进行操作。 

此外，在可编程控制器 CPU 处于运行状态下进行程序变更(运行中写入)时，根据操作条件有时会

发生程序被损坏等问题。应在充分了解 GX Developer 操作手册中记载的注意事项的基础上进行

操作。 
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修订记录 
* 手册编号在封底的左下角。 

印刷日期 *手册编号 修改内容 

2007 年 03 月 SH(NA)-080666CHN-A 第一版 

   

日文手册原稿：SH-080364-E 

 

本手册未被授予工业知识产权或其它任何种类的权利，亦未被授予任何专利许可证。三菱电机对使用本手册中的内容
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前言 

在此感谢贵方购买了三菱电机的产品。 

在使用之前应熟读本书，在充分了解产品的功能/性能的基础上正确地使用本产品。 

此外，请将本手册交给最终用户。 
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关于手册 

与本产品有关的手册如下表所示。 

请根据需要参考本表。 

 

关联手册 

 

手册名称 手册编号 

GX Developer 版本 8操作手册(入门篇) 

介绍 GX Developer 的系统配置、安装方法、启动方法等有关内容。 

 (另售) 

SH-080355 

GX Developer 版本 8操作手册 

介绍 GX Developer 的程序创建方法、打印输出方法、监视方法、调试方法等有关内容。 

 (另售) 

SH-080311C 

GX Developer 版本 8操作手册(功能块篇) 

介绍 GX Developer 的程序创建方法、打印输出方法等有关内容。 

 (另售) 

SH-080359 

结构化文本(ST)编程参考手册 

本书以初次编制结构化文本(ST)程序的读者为对象，通过样本程序介绍了基本的操作方法及功能。 

 (另售) 

SH-080665CHN 

QCPU(Q 模式)编程手册(结构化文本篇) 

介绍结构化文本语言的编程方法有关内容。 

 (另售) 

SH-080363 

QCPU(Q 模式)/QnACPU 编程手册(公共指令篇) 

介绍顺控指令、基本指令以及应用指令的使用方法有关内容。 (另售) 
SH-080450CHN 

GX Simulator 版本 6操作手册 

介绍用于 GX Simulator 的软元件内存的监视、设备侧的动作模拟的设置、操作方法等有关内容。 

 (另售) 

SH-080163 

 

备注 

各操作手册及结构化文本(ST)编程参考手册与软件包一起被刻录在 CD-ROM 中。 

希望单独购买编程手册时，由于配备有另售的印刷品，因此请通过上表的手册编号

(型号代码)定购。 
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手册的阅读方法 

 

关于该手册 ... 

本手册是对使用 GX Developer创建结构化文本(ST) 程序的操作方法进行详细说明的

说明书。需要了解相关操作的详细信息时请参阅本书。 

“第 1章 概要”中记述了结构化文本(ST) 语言的概要、安装方法、结构化文本(ST) 

程序的创建画面配置以及名称、对应的可编程控制器 CPU等有关内容。 

“第 2章 ST 程序创建步骤”以流程图的方式记述了结构化文本(ST) 程序的创建步

骤。 

“第 3章 ST 编程”记述了结构化文本(ST)程序的新建方法以及便于输入的编辑功能

的操作方法等有关内容。 

“第 4章 在线”记述了将创建的结构化文本(ST)程序写入到可编程控制器 CPU 中的步

骤以及软元件测试的操作方法等有关内容。 

“第 5章 打印”记述了打印的操作步骤等有关内容。 

 

本手册中使用的符号及内容如下所示: 

符号 内容 示例 

Point 记述了作为该项目相关知识应预先了解的内容，预先了解

可带来方便的内容。 
 

[  ] 菜单栏的菜单名 [Project] 

(  ) 工具栏中的图标 ( ) 

<<  >> 对话框的选项卡名 <<Select file>> 

        对话框的指令按钮  Jump  按钮 

 

编程手册... 

“QCPU(Q 模式)编程手册(结构化文本篇)”是用于使用 GX Developer进行结构化文本

(ST)编程时参考。适合于具有可编程控制器/梯形图程序相关知识的具备编程经验的用

户、具有 C语言等的高级语言相关知识的具备编程经验的用户。 

 

初次使用结构化文本语言时... 

请参阅“结构化文本(ST) 编程参考手册”。该手册记述了结构化文本(ST)语言的概

要、通过 GX Developer创建结构化文本(ST)程序后写入到可编程控制器 CPU 中的步骤

以及必要的信息等有关内容。 

 

需要了解结构化文本编程以外的信息时... 

请参阅“GX Developer版本 8操作手册”，或者“GX Developer版本 8操作手册(入

门篇)”。 
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本手册中使用的总称、简称 

 

在本手册中，将 GX Developer软件包、可编程控制器 CPU通过以下的总称、简称表

示。需要标明相关型号时，将记述模块的型号。 

 

总称/简称 内容／对象模块 

ST 结构化文本的简称。 

GX Developer 
产品型号为 SW8D5C-GPPW、SW8D5C-GPPW-A、SW8D5C-GPPW-V、SW8D5C-GPPW-VA的

产品统称名。 

FB 功能块的简称。 

基本模式 QCPU 功能版本 B以后的 Q00JCPU、Q00CPU、Q01CPU 的总称。 

高性能模式QCPU Q02(H)CPU、Q06CPU、Q12HCPU、Q25HCPU 的总称。 

过程 CPU Q12PHCPU、Q25PHCPU 的总称。 

冗余 CPU Q12PRHCPU、Q25PRHCPU 的总称。 

QCPU(Q 模式) 
QOOJ、Q00、Q01、Q02(H)、Q06H、Q12H、Q12PH、Q12PRH、Q25H、Q25PH、

Q25PRHCPU 的总称。 
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备忘录 
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MELSOFT 
1 概要 

1 概要 

本手册介绍 GX Developer 版本 8软件包(以下简称为 GX Developer)的结构化文本(以

下简称为 ST)的编辑操作有关内容。 

关于除 ST以外的各功能说明，请参阅“关联手册”中记载的各手册。 

 

1.1 ST 语言 

ST 语言是指，关于开放/控制中的逻辑记述方式所制定的国际标准 IEC61131-3 中定义

的语言。 

在 ST 语言中支持运算符、控制语句、函数，可以进行如下记述: 
 

· 通过条件语句进行的选择分支、通过重复语句进行的重复等的控制语句 

· 使用运算符(*、/、+、-、<、>、= 等)的公式 

· 用户定义的功能块(FB)的调用 

· 函数的调用(MELSEC 函数/IEC 函数) 

· 包含汉字等的全角字符的注释记述 
 

ST 语言的主要特点如下所示: 
 

(1) 文本格式的自由记述 

ST 语言可以以半角英文、数字的文本格式进行记述。在注释及标识中，也可以

使用汉字等的全角字符。 

 
 

(2) 可以进行与 C语言等的高级语言相同的编程 

ST 语言可以与 C语言等的高级语言一样，记述通过条件语句进行的选择分支及

通过重复语句进行的重复等的语句控制。因此，可以简洁地编写易于看懂的程

序。 

 

 

 1 
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1 概要 

 

(3) 可以容易地记述运算处理 

ST 语言可以对列表及梯形图中难以记述的运算处理简洁易懂地加以记述，程序

的可读性优良，适用于复杂的算术运算/比较运算等领域。 
 

 
 

  

   

在 ST 程序中，以使用标识为前提。 

应预先了解标识的使用方法。 

 

 

 1  
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1.2 特点 

ST 程序是通过 ST语言进行记述的程序。 

通过使用 GX Developer 创建 ST 程序，可以在优良的操作环境下进行高效的编程。 

MELSEC-Q 系列中 ST程序的主要特点如下所示: 

 

(1) 通过部件化可以提高设计效率 

在 ST语言中通过预先执行部件化操作将常用的处理定义为功能块(FB)，可以调

用各程序的必要部分。由此，在提高了程序开发效率的同时，也减少了程序错

误，提高了程序的质量。 

 

有关详细内容请参阅关联手册中记载的“GX Developer 操作手册(功能块

篇)”。 

 

(2) 可以在系统运行过程中更改程序(运行中写入) 

可以在不停运可编程控制器 CPU 的状况下，对正在执行的程序进行部分变更。 

 

(3) 与其它语言程序的关系 

MELSEC-Q 系列也支持除 ST语言以外的其它语言，因此可以使用适用于处理对象

的语言以提高编程效率。 

高性能模式 QCPU 及过程 QCPU 可以以文件为单位设置执行条件，可以将多个程序

文件写入到可编程控制器 CPU 中。 

由于可支持多种语言，可对较大范围内的用途执行最佳控制。 

 

(4) 丰富的函数群 

在 MELSEC-Q 系列的 ST程序中，配备了对应于 MELSEC-Q 系列用的各种通用指令

的 MELSEC 函数、IEC61131-3 中定义的 IEC 函数。 

 

有关详细内容请参阅“QCPU(Q 模式)编程手册(结构化文本篇)”。 
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1.3 安装 

本节介绍创建 ST程序所必需的安装方法及运行环境。 

 

1.3.1 安装方法 

在执行安装前应确认以下内容: 

 

  

   

· 在执行安装前，应结束所有在 Microsoft
R
 Windows

R
操作系统下运行的其它应

用程序。 

· 使用 Windows NT
R
 Workstation 4.0、Windows

R
 2000 Professional、

Windows
R
 XP Professional 时，应以具有 administrator(用于计算机管理)属

性的用户登录。 
 

1) 选择 Windows
R
的[Start(开始)]→[Explorer(资源管理器)]，启动资源管理

器。 

2) 点击插入了 CD-ROM 的驱动器。 

双击“Setup.exe”。 

3) 按安装向导的步骤进行设置、选择。 

4)在“ST (Structured Text) language programming function(结构化文本(ST)

语言编程功能)”的勾选框中进行勾选，执行安装。 
 

 
 

备注 

有关详细内容请参阅“GX Developer 操作手册(入门篇)”。 
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1.3.2 运行环境 

使用 ST语言编程功能时的运行环境如下所示: 

 

项目 内容 

基本软件 Microsoft R  Windows R  98 2nd Edition 以后 

Microsoft R  Windows NT R 4.0Workstation Service Pack 3 以后 

Microsoft R  Windows R  2000 Professional Operating System 

Microsoft R  Windows R  Millennium Edition Operating System 

Microsoft R  Windows R  XP 

(Home edition, Professional edition) 

CPU Pentium R  II 450MHz 以上 

画面 仅 800×600 像素以上、小字体 

安装时  

 必要存储器容量 64MB 以上 

 必要磁盘容量 130MB 以上 

运行时  

 必要存储器容量 64MB 以上 

 必要磁盘容量 100MB 以上 

 

  

   

Windows 95不支持 ST语言功能。 

 

备注 

有关详细内容请参阅“GX Developer 操作手册”。 
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1.4 ST 程序的创建画面结构及名称 

本节介绍画面结构、功能一览、按键操作等基本内容。 

 

1.4.1 ST 编辑画面 

(1) 主窗口的画面结构及各部分的名称 

 
 

(2) 各部分的名称及功能 
 

名称 功能 

主菜单 选择菜单。 

工具栏 点击选中的图标时将执行功能。 

工程窗口 管理程序及各种数据。 

ST 编辑画面 是编辑 ST程序的画面。 

监视画面 显示程序的执行状态。 

指示栏 显示编辑中的状态。 

显示编辑画面的光标位置。 
状态栏 

显示程序画面的光标模式。 
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(3) 关于快捷键及工具栏 

 

1) 快捷键 

快捷键是为了能够通过键盘进行菜单选择及指令输入而分配的按键。 

 

2) 工具栏 

是用图标表示菜单的栏。 

工具栏的显示/隐藏是在[View(显示)]→[Toolbar(工具栏)]中指定。 

 

<ST 编辑画面中常用的快捷键及工具栏一览> 
 

概要 快捷键 工具栏 右击鼠标 

移动至起始 Ctrl + Home — — 

移动至最后 Ctrl + End — — 

全选 Ctrl + A — — 

打印 Ctrl + P  — 

剪切 Ctrl + X   

复制 Ctrl + C   

粘贴 Ctrl + V   

撤消 Ctrl + Z   

恢复 Ctrl + Y   

写入 —  — 

软元件登录监视 —  — 

软元件批量监视 —  — 

参数校验 —  — 

选择函数 Shift + F11 —  

选择标识 F11 —  

工程数据一览 Alt + 0 — — 

查找 Ctrl + F   

向下查找 F5  — 

向上查找 Shift + F5  — 

替换 Ctrl + H   

换行 Ctrl + J  — 

书签设置/解除 Ctrl + F7   

书签一览 —  — 

向下查找书签 F7  — 

向上查找书签 Shift + F7  — 

解除所有书签 —  — 

转换/编译 F4  — 
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概要 快捷键 工具栏 右击鼠标 

转换/编译 

(正在编辑的所有程序) 

Ctrl + Alt + F4 
 — 

转换(运行中写入) Shift + F4 — — 

开始监视(全部窗口) Ctrl + F3 — — 

停止监视(全部窗口) Ctrl + Alt + F3 — — 

开始监视 F3  — 

停止监视 Alt + F3  — 

软元件测试 Alt + 1   

远程操作 Alt + 6 — — 
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1.5 规格 

本节介绍在 GX Developer 中用于 ST程序的规格有关内容。 

 

1.5.1 对应可编程控制器 CPU 

可与 ST程序对应的可编程控制器 CPU 的机型如下所示: 
  

基本模式 QCPU 高性能模式 QCPU 过程 CPU 冗余 CPU 

Q00CPU 

Q00JCPU 

Q01CPU 

Q02CPU 

Q02HCPU 

Q06HCPU 

Q12HCPU 

Q25HCPU 

Q12PHCPU 

Q25PHCPU 

Q12PRHCPU 

Q25PRHCPU 

 

1.5.2 ST 编辑画面的规格以及注意事项 

ST 编辑画面的文本输入有如下所示的限制: 
  

最多字符数 839680 个字符(换行代码占用 2个字符。) 

最大列数(显示区域) 999 个字符 

最大行数 65535 行 
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备忘录 
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2 ST 程序创建步骤 

以流程图表示 ST编程的大致步骤。 

以下为在功能块中创建部件，然后通过 ST语言创建主程序的示例。 

 

 
 

  

   

·该大致步骤仅供参考。各操作可通过任意顺序进行操作。 

·FB 定义可通过 ST语言或者梯形图进行记述。 

 

 

 

 

 2 
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备忘录 
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3 ST 编程 

本章介绍使用 ST程序创建工程的创建方法/编辑方法有关内容。 

 

3.1 工程的新建 

本节介绍工程的新建方法有关内容。 

 

[设置目的] 

为了新建工程对必要的 PLC 系列/PLC 类型/标识设置/程序类型以及工程名进行设

置。 

 

[操作步骤] 

选择[Project(工程)]→[New project(新建工程)]、点击(  )或者按下  

 Ctrl  +  N  。 

 

[设置画面] 

 
 

[项目说明] 

1) PLC 系列 

选择 PLC 系列。 

PLC 系列如下所示: 

·QCPU(Q 模式) ·QCPU(A 模式) 

·QnACPU 系列 ·ACPU 系列 

·运动控制(SCPU) ·FXCPU 系列 

 

 

 

 

 

 

 3 
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2) PLC 类型 

选择使用的可编程控制器 CPU 类型。 

 

3) 标识设置 

创建标识程序时进行此设置。 

 

4) 程序类型 

对创建的程序类型进行设置。 

选择了“ST”时，需要在标识设置中设置“Use label(使用标识)”。 

 

[设置步骤] 

i) 将 PLC 系列设置为 QCPU(Q 模式)。 

ii 将 PLC 类型设置为所使用的可编程控制器 CPU。 

iii) 将标识设置设置为“Use label(使用标识)”。 

iv) 将程序类型设置为“ST”。 

v) 在勾选了“Setup project name(设置工程名)”后点击  OK  按钮创建新的

工程。 

在程序创建前或者创建后均可进行“Setup project name(工程名设置)”的

设置。 

 

备注 

以下介绍工程的读取、复制时的注意事项。 

 

● 读取工程 

以未安装 ST语言功能的版本 7以前的 GX Developer 读取包含有 ST程序的工程

时，将显示以下的出错信息，无法对工程进行读取。 

 

 
 

● 复制工程 

复制工程时，复制的 ST程序/FB 将变为未转换(未编译)状态。 

复制后，应再次进行转换(编译)。 

 

 有关详细内容请参阅关联手册中记载的“GX Developer 操作手册”。 

 

 

 

 

 

 

3  
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3.2 输入 ST 程序 

在 ST编辑画面中，可以与一般的文本编辑器一样自由地进行编辑操作。 

以下介绍便利的输入功能。 
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3.2.1 输入函数 

[设置目的] 

虽然可以直接输入函数，但在不知道函数名时可以使用函数选择功能进行输入。 

 

[操作步骤] 

选择[Edit(编辑)]→[Select function(选择函数)]或者按下  Shift  +  F11  。 

 

[设置画面] 

 
 

[项目说明] 

1) 函数分类列表框 

可选择的函数的分类如下所示。 

 

分类 内容 

全部 
将所有 MELSEC 函数、IEC 函数按名称顺序(升序)显示在

函数一览列表框中。 

MELSEC 函数 
将所有 MELSEC 函数按名称顺序(升序)显示在函数一览列

表框中。 

IEC 函数 
将所有 IEC 函数按名称顺序(升序)显示在函数一览列表

框中。 

 

备注 

关于 MELSEC 函数、IEC 函数，请参阅“QCPU(Q 模式)编程手册(结构化文本篇)”。 
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2) 函数一览列表框 

显示在函数分类列表框中选择的函数一览。 

 

3)  OK  按钮 

将函数一览列表框中选择的函数插入到 ST编辑画面中。 

 

[设置步骤] 

i) 从函数一览列表框中选择使用的函数。 

ii) 点击  OK  按钮或者  Enter  键后函数将被插入到 ST编辑画面的光标位置

上。 

插入后，输入自变量完成函数。 
 

 
 

  

   

· 通过双击也可插入。 

(例: TIMER_M) 

  
· ST 编辑画面为覆盖模式时也可插入。 

· 在打开函数选择画面的状态下键入函数名的第一个字母，光标将移动至包含该第

一个字母的函数名的起始处。 

 

备注 

自变量可以以工具条形式显示。 

有关详细内容请参阅“3.3.2 函数自变量的显示”。 
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3.2.2 输入标识 

[设置目的] 

在创建 ST程序的过程中如果不知道标识名，可以使用标识选择功能进行输入。 

 

[操作步骤] 

选择[Edit(编辑)]→[Select label(选择标识)]或者按下  F11  。 

 

[设置画面] 

 
 

备注 

标识是在全局变量(标识)设置画面及本地变量(本地标识)设置画面中设置。 

有关详细内容请参阅关联手册中记载的“GX Developer 操作手册”。 

 

[项目说明] 

1) 标识一览 

显示对应于 ST编辑画面的全局变量及本地变量中设置的标识/常数値/软元件类

型以及注释。 

显示的标识是以名称顺序显示。 
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[设置步骤] 

i) 选择要输入的标识。 

ii) 点击  OK  按钮后，标识名的字符串将被插入到 ST编辑画面上的光标位置。 
 

 
 

  

   

· 通过用鼠标双击也可进行插入。 

(例: Line_A_start) 

  
· ST 编辑画面为覆盖模式时也可进行插入。 

· 在打开标识选择画面的状态下键入标识名的第一个字母后，光标将移动至包含该

第一个字母的标识名的起始处。 

· 可以对标识的显示颜色进行变更。 

关于显示颜色的变更请参阅“3.5.2 更改显示颜色”。 
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3.2.3 创建注释 

[设置目的] 

通过输入注释，提高程序的可读性。 

注释是用“(*”及“*)”围住后输入。 

 

[设置画面] 

 
 

  

   

· 在不能识别注释时的情况如下所示: 

  
· 注释不同于在梯形图程序中使用的声明/注解/软元件注释。 

· 可以更改注释的显示颜色。 

关于显示颜色的变更请参阅“3.5.2 更改显示颜色”。 

 

备注 

有关详细内容请参阅关联手册中记载的“QCPU(Q 模式)编程手册(结构化文本

篇)”。 
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3.2.4 控制语句大写字母转换功能 

[设置目的] 

在 ST编辑画面中以小写字母输入了控制语句时，将被自动地转换为大写字母。 

通过自动转换控制语句的对象字符可以防止发生输入错误。 

 

[设置画面] 

 
 

● 对象字符 

转换为大写字母的对象的控制语句如下所示: 
 

IF、THEN、ELES、ELSIF、END_IF、 

CASE、END_CASE、 

FOR、TO、BY、DO、END_FOR、 

WHILE、END_WHILE、 

REPEAT、UNTILL、END_REPEAT、 

EXIT、RETURN、 

TRUE、FALSE、MOD、AND、XOR、OR 

● 不转换的条件 

注释文内以“(*   *)”方式输入字符时不进行转换。 

 

  

   

· 转换的时机为输入了对象字符后或者输入了作为字符的分割符的键(空格、

Enter、Tab)时。 

· 可以更改控制语句的显示颜色。 

关于显示颜色的变更请参阅“3.5.2 更改显示颜色”。 
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3.2.5 自动缩进功能 

 

[设置目的] 

在 ST编辑画面中，希望使换行时字符的开始位置设置为相同的情况下进行此设置。 
 

 

 

  

   

· 自动缩进的对象键为 Tab 及半角空格。 

· 关于自动缩进的设置请参阅“3.5.1 自动缩进/标签宽度更改”。 
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3.3 方便的编辑功能 

本节介绍与 ST编辑画面的显示相关的方便的功能。 
 

 
 

其它编辑功能 

 

· 查找/替换 

在 ST 编辑画面中，查找/替换指定的字符串。 

有关详细内容请参阅“3.3.5 查找/替换”。 

 

· 行跳转 

用于在 ST编辑画面中，移动至任意的行。 

有关详细内容请参阅“3.3.6 行跳转”。 

 

· 打开 FB画面 

可以将 ST编辑画面中使用的 FB的定义内容作为参照画面显示。 

有关详细内容请参阅“3.3.7 打开 FB 画面”。 

 

· 复制/剪切/粘贴 

有关详细内容请参阅“3.3.8 复制/剪切/粘贴”。 

 

· 撤消/恢复 

有关详细内容请参阅“3.3.9 撤消/恢复”。 
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3.3.1 使用书签 

书签用于跳转至特定的行。 

是编辑时将其设置为查找标记可带来方便的功能。 

 

(1) 书签的设置/解除 

 

[设置目的] 

在 ST程序的行中附加标记时，以及将附加的标记删除时进行此设置。 

 

[操作步骤] 

将光标移动至要进行设置/解除的行。 

选择[Find/Replace(查找/替换)]→[Bookmark setting/release(书签设置/解

除)]、点击(  )，或者按下  Ctrl  +  F7  。 

 

[显示画面] 
 

 
 

  

   

可以通过[Find/Replace]→[Find]的“Bookmark setting”，将查找的字符串的所

在行一次进行全部设置。 

有关详细内容请参阅“3.3.5 查找/替换”。 

 

最多可以设置 100 个书签。 

当超出 100 个时，将显示以下的出错信息。 
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(2) 书签的全部解除 

 

[设置目的] 

用于将 ST程序中设置的书签一次性全部解除。 

 

[操作步骤] 

选择[Find/Replace(查找/替换)]→[Release all bookmarks(书签全解除)]或者点

击(  )。 

 

选择“Release all bookmarks”时，将显示以下的确认信息。 

应在确认的基础上执行操作。 
 

 
 

(3) 书签行的查找 

 

[设置目的] 

用于通过 ST程序查找指定的书签行。 

 

[操作步骤] 

操作方法如下所示: 
 

查找方向  操作步骤 

从光标位置向下方向 [Find/Replace]→[Find bookmark downward(向

下查找书签)]、点击(  )或者按下 F7  

从光标位置向上方向 [Find/Replace] → [Find bookmark upward(向

上查找书签)]，点击(  ) 或者按下 

 Shift   +  F7  。 

 

从光标位置沿查找方向跳转至最近的书签行。 
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(4) 书签一览 

 

[设置目的] 

用于从登录的所有书签中，选择希望跳往的行。 

 

[操作步骤] 

[Find/Replace]→[Bookmark list(书签一览)]或者点击(  )。 

 

[显示画面] 
 

 
 

[项目说明] 

1) 一览表示列表框 

书签信息是以“******(行数):*****(登录内容)”的格式显示。 

显示书签一览画面时，处于选择了起始行的状态。 

2)  Jump  按钮 

从一览表示列表框中选择跳转行后，点击  Jump  按钮，光标将被移动至设置了

书签的行上。 

 

  

   

通过双击鼠标也可移动光标。 
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3.3.2 函数自变量的显示 

[设置目的] 

在输入函数的过程中不知道自变量时，可以显示及参照函数自变量。 

 

[操作步骤] 

在[View(显示)]→[Function parameter(函数自变量)]中勾选函数自变量。 

通过从函数选择画面中选择进行输入，或者通过键盘输入至“(”为止，将以工具条

的形式显示函数自变量。 

 

[设置画面] 
 

 
 

  

   

有关函数类型的详细内容请参阅关联手册中记载的“QCPU(Q 模式)编程手册(结构化

文本篇)”。 
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3.3.3 窗口拆分 

[设置目的] 

在编辑程序的过程中希望显示画面中未显示的位置时，将窗口进行上下拆分显示。 

 

[操作步骤] 
● 拆分窗口时 

选择[Window(窗口)]→[Divide into two(拆分为 2个)] 

● 解除拆分状态时 

选择 [Window]→[Divide into two]. 

 

[显示画面] 
 

 
 

  

   

对二个窗口均可进行编辑。 
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3.3.4 标识信息的显示 

[设置目的] 

用于将 ST程序进行转换(编译)后，对标识中分配的软元件进行确认。 

 

[操作步骤] 

在[View(显示)]→[Label information(标识信息)]中勾选标识信息。 

在 ST 编辑画面上将鼠标指针对准标识时，将以工具条形式显示标识信息。 

 

[显示画面] 
 

 
 

以下介绍标识信息的显示形式: 

● 未进行转换(编译)时 

标识名 -> 标识类型 -> 标识注释 

● 进行了转换(编译)时 

标识名 -> 标识类型 -> 标识注释-> 软元件 

 

标识类型为全局变量时显示为“GLOBAL”，为局部标识时显示为“LOCAL”。 

 

  

   

· 在不存在标识注释时，不显示标识注释。 

· 由于在转换(编译)前未分配软元件，因此不能显示软元件信息。 

· 使用 FB或者结构体时，将显示 FB定义名或者结构体定义名。 
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3.3.5 查找/替换 

(1) 查找 
 

[设置目的] 

在 ST编辑画面中查找指定的字符串。 
 

[操作步骤] 

选择[Find/Replace]→[Find] 或者按压  Ctrl  +  F  。 
 

[设置画面] 
 

 
 

[项目说明] 

1) 查找字符串 

输入要查找的字符串。 

此外，也可从列表框中显示的字符串中选择。 
 

  

   

· 查找字符串时，应在半角 256 个字符以内进行指定。 

· 在查找字符串的列表框中，将显示从新查找的字符串算起最多 10个以前查找过

的字符串。 
 

2) 大写字母及小写字母的区分 

选择是否区分大写字母及小写字母。 

3) 以单词为单位查找 

选择是否以单词为单位进行查找。 

作为查找对象的字符串，是仅由字母的集合或者数字的集合。 

Tab/空格/_(下划线)等被识别为分割符。 
 

例: 以“abc”进行查找时 
 

字符串 查找結果 字符串 查找結果 

abcdef  abc!def  

abc t ab  def  abc01234  

abc  def  01234abc  

abc_    

× ××查找･･･ ；○ 可查找･･･  
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4) 不查找注释文内 

选择是否查找注释文内。 

5)  Find next  按钮 

开始查找。 

6)  Set bookmark(设置书签)  按钮 

查找 ST编辑画面上的与 ST 程序相关的查找字符串，在与字符串一致的所有行上

设置书签。 

 

[设置步骤] 

i) 向下查找时 

输入要查找的字符串后点击  Find next  按钮。 

 

● 找到查找字符串时 

查找到的字符串以被选中范围的状态显示。光标将移动至查找到的位置上。 

若要继续查找，则执行以下操作: 

· 向下查找 

选择 [Find/Replace] → [Find downward] 或者按压  F5 . 

从光标所在位置开始向下方查找。 

· 向上查找 

选择 [Find/Replace] → [Find upward] 或者按压  Shift  +  F5 . 

从光标所在位置向上方查。 

 

● 未找到查找字符串时 

将显示以下信息: 
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ii) 通过书签设置进行查找时 

输入设置为查找字符串的字符串后，点击  Set bookmark  按钮。 

在 ST 编辑画面上的查找字符串所在行均被设置了书签。 
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(2) 替换 
 

[设置目的] 

查找到 ST 编辑画面内的目标字符串后替换为指定的字符串。 
 

[操作步骤] 

选择 [Find/Replace] → [Replace]或者按压  Ctrl  +  H  。 
 

[设置画面] 
 

 
 

[项目说明] 

1) 旧字符串 

输入要替换的旧字符串。 

此外，也可从列表框中选择字符串。 

2) 新字符串 

输入希望替换为的新字符串。 

此外，也可从列表框中选择字符串。 

 

  

   

· 旧字符串及新字符串均应在半角 256 个字符以内指定。 

· 在旧字符串与新字符串的列表框中将显示以前替换的字符串，从最近的算起最多

可显示 10个字符串。 

 

3) 替换范围 

选择了“Current window(当前窗口内)”时 

在当前正在编辑中的程序内进行替换。 

选择了“Selected range(选择范围内)”时 

在通过鼠标拖放所选择的范围内进行替换。 

在 ST 编辑画面上选择了替换范围后，可以选择替换画面的“Selected 

range(选择范围内)”。 

4)  Find next(查找下一处)  按钮 

开始查找。 

5)  Replace(替换)  按钮 

仅对最初查找到的字符串进行替换。 

6)  Replace all(全部替换)  按钮 

对对象 ST 编辑画面内的所有相应字符串进行替换。 
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· 替换处理的对象范围可从“Current window(当前窗口内)”及“Selected 

range(选择范围内)”二者中选择。在未进行范围选择时，将以“Current 

window”作为为替换对象。 

· 在新字符串单元格中未设置字符串的状态下如果点击了  Replace  按钮，ST编

辑画面上的旧字符串将被删除。 

 

● 在进行全部替换时找到替换字符串的情况下 

将显示以下的信息: 
 

 
 

● 未找到查找字符串时 

将显示以下信息。光标不移动。 
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3.3.6 行跳转 

[设置目的] 

用于将光标移动至 ST编辑画面内的指定行。 

 

[操作步骤] 

选择 [Find/Replace] → [Line jump(行跳转)] 、点击(  ) 或者按压 

 Ctrl  +  J  。 

 

[设置画面] 
 

 
 

[项目说明] 

1) 行设置编辑框 

输入使光标跳转的行。 

2)  Jump  按钮 

使光标跳转到指定的行。 

 

  

   

指定的行超出所编辑的程序时，光标将被移动至程序的最终行处。 

 

显示了以下出错信息时，不能执行行跳转。 

应确认出错内容后重新进行设置。 

 

● 在指定行被设置为 65536 行以上或被设置为非整数的状态下点击  Jump  按钮时 
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3.3.7 打开 FB 画面 

[设置目的] 

使用 FB画面对 ST程序中使用的 FB定义程序的内容进行确认。 

 

[操作步骤] 
● 选择 FB 名。 

选择 [View]  [Open Function Block(打开 FB 画面)]或者鼠标右击[Open 

Function Block]. 

(FB 名: T_FB) 
 

 
 

显示 FB 画面。 

(显示 T_FB 程序的内容) 
 

 
 

  

   

不能进行用于读取专用的编辑操作。 
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显示以下的出错信息时，将无法打开 FB 画面。 

应确认出错内容后重新进行设置。 

 

● 未转换(未编译)FB 定义时 
 

 
 

● 选择的字符串未被定义为 FB名时 
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3.3.8 复制/剪切/粘贴 

● 复制时 

  [操作步骤] 

选择[Edit(编辑)]→[Copy(复制)]、点击(  )或者按压  Ctrl  +  C  。 

 

i)  指定要复制的字符串的范围。 

ii) 复制指定范围的字符串。 

 

● 剪切时 

  [操作步骤] 

选择[Edit]→[Cut(剪切)]，点击(  ) 或者按压  Ctrl  +  X  。 

 

i)  指定要剪切的字符串的范围。 

ii) 剪切指定范围的字符串。 

 

● 粘贴时 

  [操作步骤] 

选择[Edit]→[Paste(粘贴)]、点击(  ) 或者按压  Ctrl  +  V  。 

 

i)  将光标移动至要粘贴的位置处。 

ii) 将复制或者剪切的字符串粘贴到光标处。 

 



 

 

 

3 - 27       3 - 27 

MELSOFT 
3 ST编编 

 

3.3.9 撤消/恢复 

[设置目的] 

可以将之前进行的编辑操作恢复为原来的状态，可以将刚才撤消的操作重新执行。 

 

[操作步骤] 
● 撤消 

选择[Edit]→[Undo(撤消)]、点击(  )或者按压  Ctrl  +  Z  。 

● 恢复 

选择[Edit]→[Redo(恢复)]、点击(  )或者按压  Ctrl  +  Y  。 

 

  

   

· 可进行撤消/恢复的操作次数 .....................40 次 

· 不能进行撤消/恢复的操作 .......................复制 

光标移动 

书签的设置/解除 

转换(编译) 

工程保存 
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3.4 转换(编译) 

[设置目的] 

将创建的 ST程序转换(编译)为可在可编程控制器 CPU 中执行的程序。 

 

[操作步骤] 
● 对当前正在编辑的程序进行转换(编译)时 

选择[Conversion(转换)]→[Convert/Compile(转换/编译)]、按压  F4  或者点

击(  )。 

● 对未转换(未编译)的所有程序进行批量转换(编译)时 

选择[Conversion]→[Convert/Compile (All programs being edited)]、点击

(  )，或者按压  Alt  +  Ctrl  +  F4  。 

● 对所有程序进行批量转换(编译)时 

选择[Conversion]→[Convert/Compile (All programs)]. 

 

  

   

选择了[Convert/Compile (All programs)]时，已转换(编译)的程序也将被重新转

换(编译)。 

由于重新进行了转换(编译)，在未更改的程序中分配的软元件有被更改的可能性。 

 

(1) 正常结束时 

标题栏的表示未转换(未编译)的“*”将消失，将显示步数。 

 

(2) 发生了错误时 

i) 在某个程序中发生了错误时 

发生了错误时，窗口标题中将显示表示未转换(未编译)的“******步*”。 

将显示如下所示的画面: 
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ii) 在多个程序中发生了错误时 

将显示如下所示画面: 
 

 
 

 选择程序名后如果点击  Detail  按钮，将显示相应程序的出错结果。 
 

 
 

iii) 跳转至出错位置的方法 

 

·在显示出错的列表中选择相应的出错后点击  Jump  按钮。 

·在显示出错的列表中选择相应的出错后按压  Enter  键或者双击鼠标。 

 

如下所示，在跳转到选择的出错行后，在指示栏中将显示表明出错位置的符号。 
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有时会发生表明出错位置的符号位置与实际的出错位置不符的情况。 

应对“Compile error(Detail)(编译出错显示(详细))”画面中显示的出错内容与

出错位置表明符号表示的行的程序内容不相符的地方进行确认。 

 

   出错位置显示示例 
 

 

 

备注 

有关出错的详细内容请参阅关联手册中记载的“QCPU(Q 模式)编程手册(结构化文本

篇)”。 
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3.5 定制 ST 编辑画面 

在 ST编辑画面上可以设置操作相关内容。 

 

3.5.1 自动缩进/标签宽度的变更 

[设置目的] 

对自动缩进/标签宽度进行设置。 

 

(1) 自动缩进 

编辑时如果按压  Enter  键将自动地执行字缩进的功能。 

(2) 标签宽度 

按压  Tab  键时对标签宽度进行设置的功能。 

 

[操作步骤] 

[Tools(工具)]→[ST editor settings(ST 编辑画面设置)]   

 

[设置画面] 
 

 
 

[项目说明] 

1) 自动缩进选择框 

勾选  : 自动缩进有效 

不勾选: 自动缩进无效 

2) 标签宽度复选框 

可以在 4、8、12中任选一个。 

3)  OK  按钮 

点击后设置将生效。 
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3.5.2 更改显示颜色 

[设置目的] 

将 ST编辑画面上的背景、注释、控制语句、标识的字符串等以指定的颜色显示。 
 

[操作步骤] 

[Tools]→[Change display color(显示颜色变更)] 
 

[设置画面] 
 

 
 

备注 

在此对与 ST 编辑画面相关的内容进行说明。其它部分请参阅关联手册中记载的“GX 

Developer 操作手册”。 

 

[项目说明] 

1) 普通窗口(字符/图的颜色) 

指定软元件名、运算符等的显示字符的颜色。 

2) 监视信息(字符/图的颜色) 

指定监视画面的显示字符的颜色。 

3) 普通窗口(背景的颜色) 

指定 ST 编辑画面的背景色。 

4) 注释 

指定注释部分的显示字符颜色。 

5) 控制语句 

指定控制语句部分的显示字符的颜色。 

6) 标识 

指定标识部分的显示字符的颜色。 
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7) 标准设置 

返回为标准设置。 

标准色如下所示: 

普通窗口(字符/图的颜色) :黒色 

监视信息(字符/图的颜色) :蓝色 

普通窗口(背景色) :白色 

注释 :绿色 

控制语句 :蓝色 

标识 :粉红色 

 

ST 编辑画面上的显示示例如下所示: 
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3.5.3 更改显示字体 

[设置目的] 

可以对 ST编辑画面及监视时使用的字体进行变更。 

 

[操作步骤] 

选择[Tools]→[Font(字体)] 

 

[设置画面] 
 

 
 

[项目说明] 

1) 字体名 

设置显示字符的字体名。 

2) 字型 

设置显示字符的字型。 

3) 字号 

设置显示字符的字号。 

4)  OK  按钮 

点击该按钮后设置将生效。 

 

备注 

默认设置如下所示: 

字体名 :MS黑体 

字型 :标准 

字号 :9 
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4 在线 

本章介绍从可编程控制器 CPU 中读取 ST程序、将 ST程序写入到可编程控制器 CPU、

监视、程序动作的确认等有关内容。 

 

4.1 PLC 读取 

从可编程控制器 CPU 中读取 ST程序。 

 

[设置目的] 

用于从可编程控制器 CPU 中读取 ST程序。 

 

[操作步骤] 

选择[Online(在线)]→[Read from PLC(PLC 读取)] 或者点击(  )。 

 

[设置画面] 

 
 

[设置步骤] 

i) 通过[Online]→[Transfer setup(连接目标指定)]设置连接目标。 

ii) 选择[Online]→[Read from PLC(PLC 读取)]显示 PLC 读取的画面。 

iii) 在<<File selection(文件选择)>>选项卡中选择相应位置。 

选择“Param + Prog（参数+程序）”按钮 

参数及程序将被选中。 

选择“Cancel all selections(取消全部选择)”按钮。 

选择将全部被取消。 

iv) 点击  Execute(执行)  。 

 

 

 

 

 

 

 

 4 
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· 在 ST 程序的 PLC 读取中，不能进行范围指定的读取。 

· 对标识程序进行 PLC 读取时，对在标识设置中选择了“Use label(使用标识)”

的工程进行创建或者读取之后，进行 PLC 读取。 

· CPU 内不存在标识程序时，在 PLC 读取对话的数据一览上将不显示“Label 

program(标识程序)”。 

 

备注 

详细内容请参阅关联手册中记载的“GX Developer 操作手册”。 

 

 

 

 

 

 

 

 

 

4  
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4.2 PLC 写入 

将创建及转换(编译)后的 ST程序写入到可编程控制器 CPU 中。 

 

[设置目的] 

用于将转换(编译)后的程序写入到可编程控制器 CPU 中。 

 

[操作步骤] 

选择[Online(在线)]→[Write to PLC(PLC 写入)]或者点击(  ) 。 

 

[设置画面] 

 
 

[设置步骤] 

i) 通过[Online]→[Transfer setup(连接目标指定)]设置连接目标。 

ii) 通过[Online]→[Write to PLC]显示 PLC 写入的画面。 

iii) 在<<File selection(文件选择)>>选项卡中选择相应的位置。 

选择“Param + Prog(参数+程序)”按钮时 

参数及程序将被选择。 

选择“Select all(全选择)”按钮时 

全部被选择。 

选择“Cancel all selections(取消全选择)”按钮时 

全部选择均被取消。 

iv) 点击  Execute(执行)  。 
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· 在 ST 程序的 PLC 写入中，不能进行范围指定的写入。 

· PLC 写入时，指定的程序处于未转换(未编译)状态的情况下，将显示以下的出错

信息，该程序的 PLC 写入将被中断。 
 

 
· PLC 写入时如果未在“Label program (ST, FB, structure)(写入标识程序

(ST、FB、结构体))”的选择框中勾选，将显示以下的出错信息。如果选择

“Yes”，将仅对执行程序进行 PLC 写入，而无法读取标识程序。 
 

 
 

 

备注 

详细内容请参阅关联手册中记载的“GX Developer 操作手册”。 
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4.3 监视 ST 程序 

监视写入到可编程控制器 CPU 中的 ST程序，确认可编程控制器 CPU 的动作状态。 

 

4.3.1 ST 程序的监视 

[设置目的] 

用于监视 ST程序，确认可编程控制器 CPU 的动作状态。 

 

[操作步骤] 
● 开始监视时 

选择[Online]→[Monitor(监视)]→[Monitor]，点击(  )或者按压  F3  。 

● 停止监视时 

选择[Online]→[Monitor]→[Stop monitor(停止监视)]，点击(  ) 或者  

 Alt  +  F3  。 

 

[表示画面] 

将显示以下的监视画面: 
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在监视画面中，将 ST编辑画面的各行中使用的变量(标识、结构体、软元件)以

“label = monitor value(标识 = 监视值)”的形式显示在监视画面侧的相同的行

中。 

此外，１行存在有多个相同的变量时，只显示最初的 1个，第 2个及以后将不显示。 

 

变量类型 ST 编辑画面 监视画面 备注 s 

位 Input := TRUE; 

Input := FALSE; 

Input = 1 

Input = 0 

TRUE 1 

FALSE 0 

Word1 = -32767 10 进制数:  6 个字符 字 Word1 := -32767; 

Word1 = H8001 16 进制数:  5 个字符 

实数 Result := 340282.338; Result = 3.403e+005  

Str1 = 16961 10 进制数: 将字符串最初的 1个字

以 10进制数表示 

6个字符 

字符串 Str1 := “ABCDEFGH” ; 

Str1 = H4241 16 进制数: 将字符串最初的 1个字

以 16进制数表示 

5个字符 

排列 Label [0] := 80; 

Label [1] := 100; 

Label [3] := 160; 

Label [0] = 80 

Label [0] = 80 

Label [0] = 80 

仅显示起始[0]的值 

显示格式根据所选择的数据类型而有

所不同。 

结构体 STR_A. name := “ABCDEFGHIJ”; 

STR_A. point := 40 ; 

STR_A. name = 16961 

STR_A. point = 40 

显示格式根据所选择的数据类型而有

所不同。 

 

  

   

· 10 进制数与 16进制数可以通过[Online] → [Monitor] → [Change current 

value monitor(Decimal)(当前值监视切换(10 进制))]或者[Change current 

value monitor(Hexadecimal)(当前值监视切换(16 进制))]进行切换。 

· 监视画面的背景色与 ST编辑画面的相同。 

显示字符使用[Tools] → [Change display color(更改显示颜色)]的“Monitor 

data(监视信息)”中选择的显示颜色。 
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4.3.2 ST 程序中发生错误时的确认方法 

以下介绍写入到可编程控制器 CPU 中的 ST程序出错时的确认方法。 
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以下以实际画面为例说明在可编程控制器 CPU 中发生 ST程序错误时的操作步骤。 

 

(1) 显示出错的 ST程序。(流程图 1)、2)的操作) 

执行“PLC diagnostics”，显示出错发生行。 

 

 

1) 确认出错内容。 

2) 点击  Error JUMP  按钮。 

 

 

 

显示出错发生行。 

 

 

(2) 通过 ST 程序判断出错位置(流程图 3)、4)的操作) 

 

根据出错发生行及出错代码判断修正内容，进行修正。详细内容请参阅关联手册

中记载的“QCPU(Q 模式) 编程手册(结构化文本篇)”。 

由于未能确定“出错代码:4101”的原因，因此执行“(3)显示出错的顺控程

序。”。 
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(3) 显示出错的顺控程序。(流程图 5)～8)的操作) 

为了显示出错的顺控程序，读取顺控程序。 

 

 

5) 重新启动 GX Developer。 

 

 

 

6) 进行 PLC 读取。 

 转下页 
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 接上页 
 

 

 

7)、8) 点击“PLC diagnostics”的  

 Error JUMP  按钮，显示列表

中的相应步。 

 

(4) 通过顺控程序判断出错位置(流程图 9)、10)的操作) 

(a) 在关联手册中记载的“QCPU(Q 模式)/QnACPU 编程手册(公共指令篇)”中确

认出错代码的内容，确定出错原因。 
 

作为 MIDW 指令的“出错代码:4101”的发生原因 

MIDW  S1  D  S2 

i) S2 的值超出了 D的字符数时。 

ii) S2 + 1 的值超出 S1的字符数时。 

 

(b) 应根据关联手册中记载的“QCPU(Q 模式) 编程手册(结构化文本篇)”的转换

结果，判断 ST程序的出错位置，修改 ST程序。 
 

“QCPU(Q 模式)编程手册(结构化文本篇)”第 6章的摘录 
 

ST 程序 转换结果 

StrResult := 

INSERT (StrData1,StrData2,IData);  

LD SM400 

$+ D11114 D11125 D11102 

AND<> D11113 K1 

MOV K1 D11100 

- D11113 K1 D11101 

MIDW D11125 D11102 D11100 

MOV D11113 D11100 

LEN D11114 D11101 

MIDW D11114 D11102 D11100 
 

(c) 对于相应软元件，通过软元件监视等进行确认，确定出错原因。 

 

(5) 将程序写入到可编程控制器 CPU 中，确认出错是否已被修正。如果尚未解决，应

重复 1)～10)的操作,修正错误。 
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4.4 运行中写入 

对顺控程序进行部分更改后，写入到处于运行状态的可编程控制器 CPU 中。 

 

[设置目的] 

用于对处于运行状态下的可编程控制器 CPU 进行写入。 

对于运行中写入对象行，在指示栏中将显示“*”。 

 

[操作步骤] 

选择[Convert(转换)]→[Convert/Compile (Online change)(转换/编译(运行中写

入))]或者  Shift  +  F4  。 

执行运行中写入时将显示以下的运行中写入确认信息。 

应在确认的基础上执行。 
 

 
 

(1) 正常结束时 

点击  OK  按钮后，对象行的指示栏中显示的“*”将消失。 
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(2) 发生错误时 

显示出错内容，中断处理。应对转换错误进行修正后，再次执行运行中写入。 

出错显示的示例(输入了“d10:=100”时) 
 

 
 

备注 

关于出错显示的详细内容请参阅关联手册中记载的“QCPU(Q 模式)编程手册(结构化

文本篇)”。 
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4.5 软元件测试 

对可编程控制器 CPU 的位软元件进行强制 ON/OFF，更改字软元件的当前值。 

 

[设置目的] 

用于更改指定的软元件/变量(标识、结构体、软元件)的值。 

 

[操作步骤] 

选择[Online]→[Debug(调试)]→[Device test(软元件测试)]、点击(  )或者按

压  Alt  +   1  。 

 

[设置画面] 
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[项目説明] 

1) 软元件 

指定要进行强制 ON或者 OFF 的位软元件。 

2)  FORCE ON(强制 ON)  按钮 

对指定的位软元件进行强制 ON。 

3)  FORCE OFF(强制 OFF)  按钮 

对指定的位软元件进行强制 OFF。 

4)  Toggle force(强制 ON/OFF 转换)  按钮 

对指定的位软元件进行强制 ON/OFF 转换。 

5) 软元件 

指定要进行当前值变更的字软元件。 

6) 设置值 

设置字软元件的更改值。 

7)  Set(设置)  按钮 

设置完毕后点击此按钮。 

字软元件的当前值将被变更。 

8) 程序指定 

指定软元件测试中使用的程序。 

9) 执行结果 

显示软元件测试的设置历史记录。 

10) 不显示执行结果(显示执行结果) 

设置是否显示软元件测试的执行结果。 

 

 

备注 

详细内容请参阅关联手册中记载的“GX Developer 操作手册”。 
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4.6 调试功能 

通过使用 GX Simulator，对通过 ST语言创建的程序设置中断点后执行中断，可以在

进行逐行监视的同时，对程序的动作进行确认。 

 

4.6.1 调试功能的流程 

在 GX Developer 上使用调试功能时的流程图示例如下所示: 
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·为了使用调试功能，需要使用 GX Simulator Ver6.16S 以后的产品。 

·关于 GX Simulator 的详细内容，请参阅“GX Simulator 操作手册”。 

·不能进行连接可编程控制器 CPU 的调试。 

 

4.6.2 调试功能的启动/结束 

[设置目的] 

启动/结束 ST 程序的调试。 

 

[操作步骤] 

选择[Online]→[Debug(调试)]→[Debug] 

 

[设置画面] 

·启动时 
 

 
 

如果点击  Yes  按钮，则开始启动调试功能。 

 

·结束时 
 

 
 

如果点击  Yes  按钮，将显示调试状态已解除的信息框，点击  OK  按钮后结束

调试功能。 
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4.6.3 中断点的设置/解除 

设置/解除中断点。 

 

[设置目的] 

设置执行中断时程序中止的中断点。 
 

[操作步骤] 

选择[Online]→[Debug]→[Break point setting/cancellation(中断点设置/解

除)]、点击  或者按压  F9  。 
 

[设置画面] 
 

 
 

[设置步骤] 
 

设置中断点时 

1) 将光标对准希望设置中断点的行。 

2) 选择[Online]→[Debug]→[Break point setting/cancellation]，点击  或

者按下  F9  。 

3) 指示栏中将显示  。 
 

解除中断点时 

1) 将光标对准设置了中断点的行。 

2) 选择[Online]→[Debug]→[Break point setting/cancellation]，点击  或

者按下  F9  。 

3) 指示栏中的  将消失。 

 

  

   

·在一个程序中最多可设置 8个中断点。 
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可设置中断点的行的限制如下表所示: 

 

No. 控制语句 可否设置中断点(〇:可   ×:不可) 

1 IF 〇: 

×: 

包含“THEN”*1 的行 

包含“END_IF”的行 

2 CASE 〇: 

〇: 

×: 

包含“OF”*2的行 

选择分支的值的后面包含有“:”(冒号)*1 的行 

包含有“END_CASE”的行 

3 FOR 〇: 

×: 

×: 

包含“DO”*1的行 

包含“FOR”的行 

包含有“END_FOR”的行 

4 WHILE 〇: 

×: 

包含有“DO”*1的行 

包含有“END_WHILE”的行 

5 REPEAT 〇: 

×: 

×: 

包含有“UNTIL”*1 的行 

包含有“REPEAT”的行 

包含有“END_REPEAT”的行 

6 EXIT 〇: 

×: 

包含有“EXIT”的行 

包含有“END_WHILE”的行 

7 RETURN 〇: 

×: 

×: 

包含有“RETURN”的行 

包含有“REPEAT”的行 

包含有“END_REPEAT”的行 

8 运算语句 〇: 语句的最后包含有“；”(分号)*3 的行 

9 FB 调用 〇: 最后包含有“；”(分号)的行 

10 函数 〇: 最后包含有“；”(分号)的行 

 

*1: 即使该控制语句内均为空白时，也可设置中断点。 

*2: 可以设置中断点，但“CASE<整数式>OF”的<整数式>为单一变量(软元件、标识)时，在 OF的行中不进行

中断，而是在最初的选择分支的值后面有“:”(冒号)的行处进行中断。 

*3: 在空白语句(只有“；”分号的语句)时，不能设置中断点。 
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4.6.4 中断执行/逐行执行 

对程序进行中断执行、逐行执行。 

 

[设置目的] 

中断执行是指，在任意设置的中断点处暂停程序的执行而执行调试。 

逐行执行是指，1行 1行地执行程序以进行调试。 
 

[操作步骤] 

选择[Online]→[Debug]→[ST debug execution]，点击  或者按压  F8  。 
 

[设置画面] 
 

 
 

[项目説明] 

1)  Break execution(中断执行)  按钮 

开始从“Execution condition(执行条件)”中选择的位置起至中断点为止的执

行。 

2)  1 Line execution(逐行执行)  按钮 

从“Execution condition”中选择的位置开始进行逐行执行。 

3) 执行条件 

指定程序调试的开始行。 

4) 停止行 

显示中断执行时停止的行编号及逐行执行中停止的行编号。 

5)  Device Test(软元件测试)  按钮 

显示软元件测试对话框。详细内容请参阅 4.5节。 

6)  Cancel(中断)  按钮 

中断正在执行的中断执行、逐行执行。 

 

  

   

· 显示 ST调试执行对话框时，可以通过按压  ALT  +  B  进行中断执行、通过

按压  ALT  +  L  进行逐行执行。 
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4.6.5 中断点一览 

显示中断点一览。 

 

[设置目的] 

用于显示中断点一览，跳转至所选择的行。 
 

[操作步骤] 

选择[Online]→[Debug]→[Break point list(中断点一览)] 
 

[设置画面] 
 

 
 

[项目説明] 

1) 一览显示列表框 

显示中断点设置的行号及声明。 

通过对准中心进行双击或者按下  Enter  键，可以执行与  Jump  按钮相同的

操作。 

2)  Jump  按钮 

点击后，将光标移动至一览显示列表框中选择的行的起始处。 

 

4.6.6 中断点全解除 

解除所有的中断点。 

 

[设置目的] 

用于解除所有的中断点。 
 

[操作步骤] 

选择[Online]→[Debug]→[Cancel all break points(中断点全解除)] 
 

[设置画面] 

  
点击  Yes  按钮后，所有的中断点将被解除。  
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本章介绍 ST程序的打印操作方法有关内容。 

关于其它的打印方法，请参阅关联手册中记载的“GX Developer 操作手册”。 

 

(1) 打印 

 

[设置目的] 

打印 ST程序。 

 

[操作步骤] 

选择[Project(工程)]→[Print(打印)]，点击(  )或者按压  Ctrl  +  P  。 

 

[设置画面] 
 

 
 

 

 

 

 

 

 

 

 

 

 5 
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[项目说明] 

1) <<ST>>选项卡 

切换到打印详细内容的设置画面。 

2) 打印范围 

指定 ST程序的打印范围。 

● 全部范围 

从 ST 程序的第 1行起至最后行为止进行打印。 

● 范围指定 

对指定的 ST程序行的范围进行打印。 

3)  Print  按钮 

打印 ST程序。 

4)  Print preview(打印预览)  按钮 

显示预览画面。 
 

[设置步骤] 

对打印所必需的信息进行设置后，点击  Print  按钮进行打印。 
 

(打印示例) 
 

 

1 Start_conditions := TRUE; 

2 End_conditions := FALSE; 

3 

4 (* Operation of Line A is started *) 

5 Part_A_flag := TRUE; 

6 

7 (* Movement OF Parts A *) 

8 IF Part_A_flag AND Start_conditions THEN 

9  Line_A_start := TRUE; 

10  TIMER_M(Operation_lamp, TC0, K30); 

11 END_IF; 

12 

13 (* Parts A AND Parts B are assembled *) 

14 IF TC0 AND Part_B_flag THEN 

15  Num_of_products := Num_of_products + 1; 

16 END_IF; 

17  

18 (* Package processing *) 

19 IF Num_of_products >= 10 THEN 

20  Completion_flag := TRUE; 

21  Num_of_products := 0; 

22 END_IF; 

 

 

  

   

· 行编号将被连号打印。 

· 在文本的中间不能进行打印时，在该位置进行换行。 

在换行的部分不放入行编号。 

· 在指定了打印范围时，从指定的行编号开始打印。 

· 一行的字符数根据打印机设置及字体而发生变化。 
 

备注 

关于 FB程序的打印，请参阅关联手册中记载的“GX Developer 操作手册(功能块

篇)。 

 

 

 

 

 

 

 

 

 

5  
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(2) 打印预览 

 

[设置目的] 

显示设置了打印范围的 ST程序的打印映像。 

 

[操作步骤] 

选择[Project] → [Print] →  Print preview  按钮、点击(  ) →  

 Print preview  按钮、或者按压  Ctrl  +  P  →  Print preview  按钮。 

 

[设置画面] 
 

 
 

[项目说明] 

1)  Print  按钮 

对打印预览画面中显示的数据进行打印。 

2)  Next Page(下页)  按钮 

显示下一页的打印映像。 

3)  Prev Page(上页)  按钮 

显示上一页的打印映像。 

4)  Two Page(2 页)  按钮 

选择打印映像是以 1页或者 2页显示。 

5)  Zoom In(放大)  按钮 

将打印映像放大后显示在画面中。 

显示可在 3等级之间切换。 

6)  Zoom Out(缩小)  按钮 

将打印映像缩小后显示在画面中。 
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备忘录 
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